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Preface
Description

The Continuous Radon Monitor is a detection device used to measure the 
concentration of radon gas. The unit is designed for professional inspectors to 
use in homes and buildings. The device is EPA verified and radon proficiency 
programs approved.

Health and Safety Instructions

To protect Radon Monitor performance and cable insulation, never pull on a cable 
to disconnect it. Always grasp the plug or connector.

Do not permit water or any other liquids to spill onto the device.

For instructions to report health or safety related concerns, see Reporting Health 
or Safety Related Issues or Concerns on page 56.

CAUTION: The Continuous Radon Monitor Model 1028 is intended to be used 
only for indoor applications of radon gas sampling. Using in an outdoor 
environment may cause errors due to humidity and extreme temperatures.

WARNING: To avoid risk of electric shock, this device must only be 
connected to a supply mains with protective earth (ground).

WARNING: Never use the device in an area that could contain 
explosive gases. A spark from inside the device could ignite an 
explosion.
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Finding Additional Information

The U.S. Environmental Protection Agency (EPA) maintains a comprehensive 
radon website at http://www.epa.gov/radon/index.html where you can find EPA 
documents, brochures, and publications relating to radon, including:

• A Citizen's Guide to Radon: The Guide to Protecting Yourself and Your Family 
from Radon. This guidance offers strategies for testing your home for radon 
and discussions of what steps to take after you have tested, as well as 
discussions about the risk of radon and radon myths.

• Consumer's Guide to Radon Reduction: How to Fix Your Home. This booklet 
is for people who have tested their home for radon and confirmed that they 
have elevated radon levels. This booklet can help with selecting a qualified 
contractor to reduce the radon levels in the home, determining an appropri-
ate radon reduction method, and maintaining a radon reduction system.

• Home Buyer's and Seller's Guide to Radon. This booklet is intended for any-
one who is buying or selling a home, real estate and relocation professionals, 
home inspectors and others.
iv
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Introduction

Parts

Unpack the radon monitor and identify the parts described below.

Figure 1. Parts Furnished with Model 1028 Radon Monitor

Note: Save the packing material so it can be used when sending the 
radon monitor to Sun Nuclear Corporation for annual re-calibration.

No.  Part Number Description
1 1028300 or

1028300-RM
Model 1028 Radon Monitor* or
Model 1028 Radon Monitor (Refurbished)

2 801041Z Cable, USB A-B M, 2 m

3 741011** Power supply, 18 VDC, 100-240 VAC, 0.3A

— 0200014 Radon Customer Support Site letter (not shown)

— 1028012 Getting Started Guide (not shown)

* Model 1029 Radon Monitor is obsolete.
**Power supply P/N 741011 is only included with Model 1028 Radon Monitors shipped 
within the United States.

1

2

3
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Options and Accessories
Contact Sun Nuclear Corporation to order any of the following accessories:

Table 1. Radon Monitor Accessories

Part Number Description

1028050 Printer, thermal, 80 column, Seiko DPU-414.

022005Z Power supply for printer, 6 VDC. Used with P/N 801008Z.

750052 Rechargeable battery pack for printer (furnished with P/N 1028050 or 
can be ordered separately).

801008Z Line power cord for printer. Detachable, IEC Plug to USA style, 1.8 m.

801032Z Serial cable for printer, 9-pin, D-connector, M/F (furnished with 
P/N 1028050 or can be ordered separately).

850043Z Thermal paper for printer (furnished with P/N 1028050 or can be 
ordered separately).

750004 Battery, alkaline, 9V, for radon monitor.

741011 Power converter for Radon Monitors shipped within the United States, 
120 VAC to 12 VDC, 200 MA, 60 Hz.

801041Z USB cable for Radon Monitor, 2 m.

1028012 Radon Monitor Getting Started Guide.

1028000-SC Carrying case, single radon monitor.

1028000-SPC Carrying case, single radon monitor plus printer.

1028000-DC Carrying case, dual (holds two radon monitors, printer, cables).

102378 Sign, self-adhesive, “Warning, Closed Building Procedure”.

102379 Sign, plastic, hanging, “Caution, Radon Test in Progress”.

1028130 Sign, vinyl static cling, “Warning, Closed Building Procedure”.
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Connections

No Description Function

1 USB PC PORT (front) USB port (USB 1.1 or 2.0); for connection to a computer

2 Serial PC PORT (front) Serial port (RS-232); for connection to a computer 

3 PRINTER PORT (front) Serial port (RS-232); for connection to the optional printer.

4 Power connection 
(back)

Power connector; connects to the power supply when 
using AC power.

5 Battery compartment 
(back)

Insert and connect a fresh 9V battery for either backup or 
primary power. A fresh alkaline battery will operate the 
radon monitor for approximately 100 hours while a fresh 
lithium battery will provide about 300 hours of operation. 
See Replacing the 9V Battery on page 6.

Figure 2. Connections

WARNING: Always install a fresh 9V battery before test or storage 
to prevent the internal 3V battery (required for operation) from 
discharging.

1

2

3
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4
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Controls

Description Function

Display 16-digit LCD display shows messages to guide the operation.

Buttons Six push buttons with different functions depending on mode. Press keys 
to operate. Top row of labels lists main functions. Bottom row of labels are 
for Setup. Print and Clear functions are used after measurement. Numbers 
are for PIN entry and Setup.

STATUS Selects the Status mode, which scrolls through the Status settings.

SETUP Selects the Setup mode, which is used to enter setup values from the 
keypad.

AVG Displays the measured cumulative average radon gas concentration in pCi/l 
or Bq/m3 since the memory was last cleared. 

CUR Displays the measured short-term radon gas concentration, a rolling aver-
age of the most recent 12 hours. 

ON Press to turn on the display. There is no OFF switch. To save power, the dis-
play turns off automatically after a few minutes of inactivity.

ALT For future use.

PIN Press to enter PIN (personal identification number), if used.

SAVE Saves the Setup mode values that were entered.

EDIT Allows editing of the Setup mode entries.

Right arrow Scrolls ahead during Setup or Status.

Left arrow Scrolls backward during Setup or Status.

Clear Clears the test memory in Print/Clear mode. Memory must be cleared 
before starting a new test.

Print Sends report data to optional printer in Print/Clear mode. 

Mode light The green light between EDIT and SAVE has the following meaning: 
• Blinks once during power up, indicating that the startup test is in prog-

ress. 
• Blinks when radon is detected.

Figure 3. Controls
4



Standalone Operation

Position the Monitor

1 Place the radon monitor in the desired position in the area to be monitored 
for radon gas. The radon monitor does not need to be level.

2 To use a tripod, thread the standard tripod screw (1/4-20UNC) into the 
threaded fitting on the bottom of the case (Figure 4).

Figure 4. Using a Tripod

Install a Fresh Battery

The radon monitor can be operated on battery power or AC power. When 
connected to AC power, the battery provides back-up power. However, even 
when operating on AC power, a battery must be installed to provide backup 
power.

With the radon monitor disconnected from AC power, a fresh alkaline battery will 
operate the device for about 100 hours, or a fresh lithium-ion battery for about 
300 hours.

WARNING: Always install a fresh 9V battery before test or storage, 
even when the unit is connected to AC power, to prevent the internal 
3V battery from discharging. The 3V battery will discharge in 15 min-
utes; the battery is not user-serviceable and if discharged, the unit 
must be returned to Sun Nuclear for replacement.
5



The battery is located in a small compartment on the back of the radon monitor 
(Figure 5). To install a new battery, Replacing the 9V Battery, below. A replacement 
9V battery can be purchased from Sun Nuclear or any retail source.

Figure 5. Inserting a Battery

Replacing the 9V Battery

The internal 3V battery will discharge in 15 minutes and if discharged, the unit 
must be returned to Sun Nuclear for replacement. Additionally, if the 3V internal 
battery is discharged, the time and date may be reset and the “Current” values 
may be permanently erased.

1 If a test is in progress, wait for the test to complete. 

2 Connect the radon monitor to AC power using the AC adapter. See 
Connecting the AC Adapter on page 7.

3 Open the battery compartment door (Figure 5) on the rear panel of the unit.

4 Remove the old battery and unsnap the connector.

CAUTION: High humidity may shorten battery life. Connect the AC 
power adapter when using the radon monitor in areas with high 
humidity.

WARNING: Always connect to AC power before replacing the 9V 
battery, to prevent the internal 3V battery (required for operation) 
from discharging. 

CAUTION: Never replace the battery during a test. 
6



5 Connect a fresh 9V battery to the connector, insert the battery into the 
battery compartment, and close the battery compartment door.

Connecting the AC Adapter
1 After verifying a battery is installed (see Figure 5 on page 6), connect the 

power cable to the power connector on the rear panel of the radon monitor. 

Figure 6. Connecting Power to the Radon Monitor

2 Plug one end of the power cord into the adapter and the other end into a 100 
to 240 VAC, 1-phase, 50-60 Hz mains power source. 

Turn on the Display

To conserve power, the 16-digit display is always off until the ON button is 
pressed. If no buttons are pressed for 2 – 3 minutes, the display turns off 
automatically.

To turn the display on:

1 Press the ON button (5). After a few seconds, the display turns on and shows 
the message “Battery OK” (Figure 7). 

2 If a Personal Identification Number (PIN) is set up, the display prompts the 
user to enter it. The company name is displayed momentarily (if set up) 
followed by the message “Checking Memory.” If there is data in memory, the 
message “Data in Memory!” appears. The data can be printed before 
clearing the memory.
7



Figure 7. Turning on the Display

3 When the display shows “Start Test = 5,” the user may start a new test, 
check AVG, check CUR, check STATUS, or change SETUP. The table below 
summarizes the steps to turn on the display.

 

Press…*  Display Shows… Comment

Battery OK

Display is always off until ON key (5) is pressed. “Bat-
tery OK” means there is enough power for 60 hours of 
operation (delay plus test). “Low/No Battery!” means 
that the battery has less than 60 hours operating life, or 
there is no battery installed. 

– Enter PIN Only appears if a Personal Identification Number has 
been set up. 

nnnn NNNN
Enter PIN using digits 1 – 4 (5 and 6 not supported; 
there are no buttons for 7 – 9). Numbers entered are 
displayed. Enter “5' after entering PIN.

Company Name
Press PIN button (5). If correct PIN was entered, com-
pany name (if set up) displays. If wrong PIN was 
entered, message “Shutting down...” appears briefly 
and then display turns off.

–
Checking 
Memory

If data is in memory, the messages “Data in Memory!” 
and “Print and Clear” are displayed. Print and Clear the 
memory before starting a new test. See Clearing Mem-
ory on page 11.

– Start Test = 5

With the display reading “Start Test = 5,” the user can 
press a button to:
• Start a test. See Starting a Test on page 9. 
• Check AVG or CUR. See Displaying Average and Cur-

rent on page 10. 
• Check STATUS. See Checking Unit Status on 

page 11.
• SETUP the unit. See Setting Up Parameters on 

page 12.

After a few minutes of inactivity, the display turns off 
automatically to save power.
8



Starting a Test

When the “Start Test = 5” prompt appears, press the 5 button to start a new test. 

Interrupting a Test 

A test in progress can be interrupted to view the average or current readings. 
After the interruption, the test can be terminated or continued.

Press…  Display Shows… Comment

– Start Test = 5 A new test can be started.

Checking Memory
Memory is rechecked. If data is found, memory 
must be cleared before starting a new test. See 
Clearing Memory on page 11.

– Delay       0 hr Displays the time delay defined in Setup. 

– Interval    1 hr Displays the measurement interval defined in 
Setup.

– Duration   12 hr Displays the test duration defined in Setup.

– Test in Progress
The test has started and will be finished after the 
duration defined in Setup (plus delay). The display 
turns off after a few minutes and remains off until 
the test is interrupted or the display is turned on.

Press…  Display Shows… Comment

Battery OK Display turns on and battery is checked.

– Enter PIN This prompt only appears if a Personal Identification 
Number was set up.

nnnn NNNN Enter the PIN using only digits 1 through 4.

NNNN
PIN number is displayed. Press PIN button (5) to 
check PIN. If the wrong PIN is entered, the mes-
sage “Shutting down...” is displayed.

– End Test Y=5 N=2

Press 5 to end a test prematurely or 2 to continue. 
Pressing 2 will turn off the display and continue the 
test. 

Note, when this message is displayed, the user 
also has the option to press AVG (3) or CUR (4) to 
display the average or current readings. See AVG or 
CUR During a Test, below.

Confirm  Y=5 N=2 Press 5 to confirm or 2 to cancel.

Test Complete The test is terminated.

– Start Test = 5
A new test may be started. If there is partial test 
data in memory, it must be cleared before starting 
a new test. See Clearing Memory on page 11.
9



Displaying Average and Current

AVG or CUR During a Test
The average (AVG) or current (CUR) radon values can be displayed during a test. 
Turn ON the display (see Interrupting a Test on page 9), and note the button press 
options in the table below.

AVG or CUR After Test
The average (AVG) and current (CUR) radon values can also be displayed after a 
test is completed. Turn ON the display (see Turn on the Display on page 7), and 
note the button press options in the table below.

Note: A completed test cannot be interrupted. After a test is 
completed, pressing ON displays the normal start sequence.

Note: AVG is the average radon concentration over the total 
monitoring period; CUR is the average radon concentration over the 
last 12-hour period.

Press…  Display Shows… Comment

– End Test Y=5 N=2 When the display shows this message, press 
AVG (3) or CUR (4) to access those functions.

 or Hold 3&4 Prt/Clr
This message only appears for a moment after 
pressing 3 or 4. If the test was just started, the 
message “Not Enough Data” is displayed.

– Average      1.2
If AVG (3) was pressed, radon monitor displays 
the average radon concentration over the total 
monitoring period.

– Current      1.2
If CUR (4) was pressed, radon monitor displays 
the radon concentration in the current 12-hour 
period. 

– Shutting down... After displaying AVG or CUR, monitor shuts 
down to resume test.

Press…  Display Shows… Comment

Start Test = 5 Press AVG (3) or CUR (4).

Hold 3&4 Prt/Clr This message only appears for a moment after 
pressing AVG (3).

– Average      1.2 Displays the average radon concentration over 
the total monitoring period.

Hold 3&4 Prt/Clr This message only appears for a moment after 
pressing CUR (4).
10



Clearing Memory

After printing the report, clear the memory using the key press options in the 
table below.

Checking Unit Status

Before starting a new test, it is recommended to scroll through the status items 
to confirm they are correct.
 

– Current      1.2 Displays the radon concentration in the current 
12-hour period. 

– Start Test = 5
AVG or CUR reading is complete. The data for the 
test remains in memory and must be cleared 
before starting a new test. See Starting a Test on 
page 9.

Press…  Display Shows… Comment

– Start Test = 5 It is recommended to print a report before clear-
ing data.

+ Prt=3 Cl=4 Ex=5
When the “Start Test = 5” message appears, 
press and hold 3 and 4. Keep holding until the 
“Prt=3 Cl=4 Ex=5” message appears. Press 4 to 
clear (or 5 to exit).

Confirm  Y=5 N=2 Press 5 to confirm the clear memory command.

Clearing Memory The memory is cleared in a few seconds.

Press…  Display Shows… Comment

– Start Test = 5 The status menu can be selected when the display 
shows “Start Test = 5.”

Status Menu
Press the (1) button to select the status menu. The 
status of each item will scroll through automati-
cally. Each item displays for about 2 seconds.

– DELAY      nn hr The delay time selected.

– INTERVAL   nn hr The measurement interval selected.

– DURATION  nnn hr The duration of the test.

– BATTERY    Ok Battery status.

– TIME    nn:nn PM Current time.

– DATE    MM DD YY Current date

– CAL   MM/DD/YYYY Date of last calibration.

– SNC MODEL   1028 Model number.

Press…  Display Shows… Comment
11



Status items can also be displayed during a test by pressing the (1) button while 
the display shows “End Test Y=5 N=2.”

Setting Up Parameters

Parameter data can be entered using a computer or by entering the characters 
with the front panel keys on the radon monitor. Using a computer is the faster of 
the two methods. For instructions to enter parameter data using a computer, see 
Monitor Settings Preferences on page 38. The table below shows the parameter 
key press options.

– CODE VER    nnnn Embedded code (firmware) version number.

– S/N  nnnnnnnnnnn Serial number.

– Status Menu Done End of the menu. Display returns to “Start Test = 
5”.

Note: If there is any test data in the radon monitor, parameters cannot 
be entered. Clear test data before changing parameters. 

Press…  Display Shows… Comment

– Start Test = 5 Parameters can be changed at any time before 
starting a test.

Setup Menu Entering setup menu.

– Checking Memory Checking memory for data.

– Delay     0.0 hr Shows current delay settings.

 or Delay      12 hr

Press arrow buttons to change value.
• If the monitor firmware version is 106 or higher, 

the delay options are 0.0 hours,12 hours, 24 
hours, or 48 hours.

• If the monitor firmware version is 105 or lower, 
the delay options are 0.0 hours or 12 hours. 

For the steps to check firmware version on a 
standalone monitor (not connected to a com-
puter), see Checking Unit Status on page 11. For 
the steps to check the firmware version from the 
computer, see Monitor Settings Preferences on 
page 38. The serial number and firmware version 
of the unit are displayed on the right side of the 
Monitor Settings screen.

Interval  1.0 hr Press SAVE; saves the Delay setting and 
advances to Interval.

 or Interval  4.0 hr
Press arrow keys to scroll through selection of 
intervals, 0.5 (model 1029 only), 11.0, 2.0, 4.0, 8.0, 
12,16, 20, or 24 hours.

Press…  Display Shows… Comment
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Duration 1.0 hr Press SAVE; saves the setting and advances to 
the next item.

 or Duration  48 hr

Press arrow keys to scroll through test duration 
times: 1.0, 12, 24, 36, 48, 60, 72, 84, 96, 100, or 
999 hours. 
If 999 is selected, measures until memory is full or 
to 720 data points, whichever occurs first.

COMPANY Company Press SAVE; saves the setting and advances to 
the next.

COMPANY Company The EDIT key (3) lets you begin to edit the first 
character.

 or COMPANY Mompany
Press the arrow keys to scroll through the avail-
able characters. See Character Set on page 14 for 
a list of characters. Press and hold for rapid scroll.

COMPANY My Comp

Press EDIT key (3) and scroll to the next and sub-
sequent characters. Press EDIT (3) again to enter 
the next character. Continue character by charac-
ter until the company name is entered (up to 30 
characters).

ADDRESS1 none Press SAVE (4); saves the setting and advances to 
the next item.

ADDRESS1 9one
The EDIT key (3) allows editing beginning with the 
first character. Enter up to 30 characters for the 
first address line using the same procedure as for 
Company name.

ADDRESS2 none Press SAVE (4); saves the setting and advances to 
the next item.

ADDRESS2 none

If a second address line is not needed, leave it 
blank. The EDIT key (3) will allow editing begin-
ning with the first character. Enter up to 30 
characters for the second address line using the 
same procedure as for Company name.

City   none Press SAVE (4); saves the setting and advances to 
the next item.

 and City   none Enter city (20 characters) and SAVE (4) (same as 
above).

 and STATE  none Enter state (10 characters) and SAVE (4) (same as 
above).

 and ZIPCODE Enter zip code (10 characters) and SAVE (4) (same 
as above).

 and PHONE Enter phone number (20 characters) and SAVE (4) 
(same as above).

 and LICENSE Enter license number (10 characters) and SAVE (4) 
(same as above).

 and TIME Enter current time (4 numbers plus AM or PM) 
and SAVE (4) (same as above). 

 and DATE Enter current date in the format MMDDYY (6 
numbers) and SAVE (4) (same as above). 

Press…  Display Shows… Comment
13



To enter parameter data using the front panel keys on the radon monitor:

1 Turn on unit.

2 Press “Setup” (button 2).

3 Advance through the list by pressing “Save” (4).

4 Stop on an item to change it.

5 Press “Edit” (3) to edit the item.

6 Press the arrow keys to scroll through a list of available characters and stop 
when the desired character appears. Press and hold arrow key for fast scroll.

7 When a desired character to change appears, press “Edit” (3) again to 
change it.

8 When all the characters are changed, press “Edit” to complete the item.

9 Press “Save” and advance to the next item.

Character Set

The available character set includes the following in the sequence shown:

(space) ! “ # $ % & ‘ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 : ; < = > ? @ A B C D E 
F G H I J K L M N O P Q R S T U V W X Y Z [ \ ] ^ _  ‘ a b c d e f g h i j k l m n 
o p q r s t u b w x y z

Display Turns Off Automatically

The display turns off automatically after a period of inactivity of about 2-3 
minutes. There is no OFF switch or key sequence.

 and UNITS   pC/l Select units, pCi/l or Bq/m3 (edit, select with 
arrows, and SAVE (4)).

 and PIN NUM 1111
Enter a PIN number if desired in the range of 1111 
to 4444 and SAVE. The number 1111 is equivalent 
to no PIN. To clear a PIN, enter 1111.

Setup Menu Done End of setup menu.

Press…  Display Shows… Comment
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Clearing a Reset

1 Turn on the radon monitor to check the battery. If the system is accidentally 
reset, clear the reset as shown in the table below.

2 Start the radon monitor again. See Turn on the Display on page 7.

3 In Setup, change the date and time. See Setting Up Parameters on page 12.

Low Battery Messages

A 9V battery must always be installed, even when using an AC power supply, to 
prevent discharge of the internal 3V battery. When the battery is low or needs to 
be replaced, a message is displayed on the radon monitor. The following sections 
describe the messages that may be displayed.

Low Battery with AC Power Connected
If the battery is low and the AC power adapter is connected, a message appears 
when key 5 is pressed. 

Replace the 9V battery as soon as the test is complete. See Replacing the 9V 
Battery on page 6.

Press…  Display Shows… Comment

Battery     OK Battery is checked. 

– System has reset System has been reset.

– Check Date/Time An alert to check the date and time and re-enter 
them.

Clear Reset? Y=5 Sets the system back to operational mode.

– Shutting down... System shuts down.

Note: A reset does not clear or change any test data stored in memory. 

Press…  Display Shows… Comment

Low/No Battery! Battery is checked. Does not have enough power 
for a 60-hour test.

– Replace Battery!
Replace the 9V alkaline battery as soon as conve-
nient. Current test can continue until complete if AC 
power is reliable.

– Shutting down... The system shuts down to save power.
15



Low Battery Without AC Power Connected
If the battery is low and the AC power adapter is not connected, a message 
appears when attempting to power on.

Connect the AC adapter to continue the test or perform any other operation. 
Replace the 9V battery as soon as possible. See Replacing the 9V Battery on 
page 6.

Storage Under Power

The radon monitor must always be stored with a 9V battery installed or connected 
to AC power. This additional power is required to prevent discharge of the 3V 
lithium battery located inside the unit. The 3V battery will discharge in 15 minutes, 
and if the internal battery is discharged, it must be replaced at the factory. See 
Contacting Sun Nuclear Support on page 54.

Press…  Display Shows… Comment

Low Battery! Battery is checked. Does not have enough power 
for a 60-hour test.

– No Extern. Power
Indicates AC power should be connected to con-
tinue the test in progress. At the conclusion of the 
test, replace the battery.

– Shutting down... The display shuts down to save power.

WARNING: For long term storage, always connect to AC power or 
install a fresh 9V battery to prevent the internal 3V battery (required 
for operation) from discharging. The 3V battery is not user-service-
able and if discharged, the device must be returned to Sun Nuclear 
for replacement. 
16



Portable Printer (Optional)

Printer - Parts

The following parts are included with the optional portable printer, P/N 1028050.

Printer - Description

The optional portable printer prints reports directly from the radon monitor. It can 
be connected to AC power or used as a portable printer by switching to battery 
power. See Printer Battery Pack on page 22.

Figure 8. Optional Portable Printer

The printer is not used to print reports from the computer. For computer reports, 
see Printing Reports on page 44.

Part Number Description

022005Z Power supply, 6 VDC out, 2.1 mm plug

750052 Rechargeable battery pack, 4.8 V Ni-MH

801008Z Line power cord for printer, detachable, IEC Plug to USA style, 
125 V, 10 A, 2.3 m.

801032Z Cable, RS-232 (serial), DB9M to DB9F, 6 ft.

850040Z Thermal printer

850043Z Thermal printer paper (roll)
17



Printer Connection and Controls

1 Connect the printer cable to the PRINTER PORT on the radon monitor and 
the serial port on the printer’s rear panel (Figure 9).

Figure 9. Connecting the Printer Cable

2 To operate the printer on AC power, plug the power supply (P/N 022005Z) 
into the power connector at the back of the printer. Then, plug the 
detachable power cord (P/N 801008Z) into the power supply and into a 
power source that matches the ratings on the power supply.

Alternately, the printer can be operated from the rechargeable battery.

Figure 10. Printer Controls

3 Slide the Power switch (on the side of the printer) to the On (I) position.

The Power LED (green) will illuminate and blink once every second. If the 
rechargeable battery pack is low, the Power LED will blink once every 1/2 
second.

Power LED

Power switch ONLINE/OFFLINE 
button

ONLINE/OFFLINE 
indicator LEDs

FEED paper 
button
18



4 To feed paper, press the ONLINE/OFFLINE button to select off line mode 
(red LED illuminated), then press the FEED button. It is only possible to feed 
paper when the printer is OFFLINE.

5 When complete, press the ONLINE/OFFLINE button to select on line mode 
(green LED illuminated). 

• The green ONLINE LED will blink if there is data in the buffer memory 
when you toggle the switch to off line mode.

• The red OFFLINE light indicates the printer is off line.

• The red OFFLINE light flashes if the paper is not set or has run out.

• Both the ONLINE and OFFLINE lights flash if there is an error.

Loading the Paper

1 Unwrap the roll of thermal paper (P/N 850043Z) and, if necessary, cut the 
leading edge straight across.

2 Open the paper cover on the printer and place the roll of thermal paper, edge 
down, in the cover (Figure 11). (Printing surface is on the inside of the roll.)

Figure 11. Loading the Paper

CAUTION: Do not press and hold the ONLINE/OFFLINE button and the 
FEED button simultaneously for 30 seconds or more. This resets the 
printer’s internal switches and prevents use of the printer.

Note: Load the paper in an area protected from direct sunlight.
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3 Press the ONLINE/OFFLINE button to select off line mode (red LED 
illuminated).

4 Push the edge of the paper into the inlet slot at the bottom of the paper 
holder until the auto-loader catches and feeds about 10 cm of paper through 
the paper cutter.

5 If necessary, keep pressing the paper FEED button until the paper feeds 
straight and smoothly.

Printing a Report 

After a test has been performed, it is recommended to print a report before 
clearing the data from memory. If there is data in memory when the display is 
powered on, the “Data in Memory!” and “Print and Clear” messages appear. Print 
a report using the key press options in the table below.

Note: If the paper is set correctly, the OFFLINE (red) LED will stop 
flashing and stay on to indicate the printer is still in off line mode.

Press…  Display Shows… Comment

– Start Test = 5 Printing can be initiated when the display shows 
“Start Test = 5.”

+ Prt=3 Cl=4 Ex=5 Press and hold 3 and 4. Keep holding until the 
“Prt=3 Cl=4 Ex=5” message appears.

Compact? Y=5 N=2 Press 3 to print (or 5 to exit without printing) 
(1029 only).

 or Graph?   Y=5 N=2 Press 5 for compact printout; press 2 for stan-
dard printout.

 or Printing... Press 5 to print the bar graph; press 2 to exclude 
it. Data is sent to the portable printer.

– Start Test = 5
Printing is complete. A new test can be started. 
The data for the test remains in memory and 
must be cleared before starting a new test. See 
Clearing Memory on page 11.
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Typical Printer Report

Figure 12. Typical Printer Report
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Movement
The movement indicator (M) indicates if the unit was moved during the displayed 
time period. The movement indicator is sensitive and can be triggered by 
bumping or minor shifting. It could also mean that the unit was moved to a 
different location during the test, invalidating the test.

Temperature, Humidity, Pressure

Model 1029 contains additional temperature, humidity, and pressure sensors. 
Changes recorded by these sensors may help to determine if the unit was moved 
or the area ventilated during the test period. 

Printer Battery Pack

The rechargeable battery pack (P/N 750052) allows the user to print reports 
without connecting the printer to AC power. The battery pack is automatically re-
charged when AC power is connected to the printer.

Inserting the Battery Pack
1 Move the power switch to the OFF (0) position. 

2 Turn the printer over and slide the battery cover away from the battery pack 
enclosure (Figure 13).

Figure 13. Inserting and Removing the Battery Pack

3 Connect the battery pack wires to the connector.

4 Turn the battery pack so the label is visible, insert it in the printer, and close 
the battery cover.

Removing the Battery Pack
1 Move the power switch to the OFF (0) position. 

2 Turn the printer over and slide the battery cover away from the battery pack 
enclosure.
22



3 Pull out the battery pack, grasp the connector between your thumb and index 
finger, and then pull gently to remove.

4 Close the battery cover.

Charging the Battery Pack
1 Turn the power switch to the OFF (0) position.

2 Connect the AC adapter to the printer. The Power LED will blink once every 
second while the battery is charging. It takes about 10 hours to completely 
recharge the battery. When the battery is fully charged, the Power LED stops 
blinking and turns off.

3 Disconnect the AC adapter.

Low Printer Battery Indication
When the Power LED blinks once every 1/2 second and the printer goes into off 
line mode, connect the AC adapter. If there is data left in the memory buffer when 
this happens, to preserve the data, connect the AC adapter as quickly as possible 
and push the ONLINE button.

Efficient Use of Printer Battery
Battery efficiency decreases if the battery is recharged more than necessary. 
Confirm whether the Power LED is blinking and battery charge is low before 
recharging the battery. 

When using the rechargeable battery, turn off the power switch after use. Leaving 
the power switch on will consume battery power and eventually run the battery 
down. 

When the AC adapter is connected, please note that the battery gradually 
recharges whether or not the printer is on or off. It takes about 15 hours to charge 
the battery with the power on. Battery charging is temporarily disrupted while the 
printer is printing and resumes automatically when printing is completed. If the 
printer is not in use, move the power switch to the OFF position and then unplug 
the AC adapter.

Note: Always charge the battery in a location that is 5 to 40 °C (41 to 
104 °F) to avoid degradation of the battery pack.
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Printer Switch Settings

The thermal printer (P/N 1028050) has internal DIP switches that are set at the 
factory. For proper operation, these switches must be set as shown in Figure 14 
on page 25. 

To check and set the switches, perform the following steps:

1 Slide the power switch to the OFF (0) position.

2 Slide the power switch to the ON (I) position while pressing and holding the 
ONLINE/OFFLINE button. 

3 Release the ONLINE/OFFLINE button after a list of the current settings 
(Figure 14 on page 25) begins to print. When the list of settings is complete, 
the following prompt appears at the bottom of the printout: 

“Continue? : Push On-line SW”
“Write? : Push Paper feed SW”

4 To leave the switch setting the same, push the FEED button.

5 To change any switch settings, push the ONLINE/OFFLINE button. The 
prompt “Dip SW-1” appears on the printout below the current settings.

6 Set each of the eight switches in Dip SW-1 by pressing the 
ONLINE/OFFLINE button=”on” or FEED button=”off”. As ON or OFF is 
selected for each switch, the printer prints the selection. When switch 8 is 
set, the printer once again prompts to “Continue?” or “Write.” Press the 
ONLINE/OFFLINE button to continue to SW-2. 

7 In the same manner, set the switches for SW-2 and SW-3.

8 When SW-3 is finished, press the FEED button to select “Write.” The 
changes are written to printer memory, and then the printer returns to on line 
mode.

CAUTION: Never turn the printer off while writing the switch set-
tings to memory. When “Dip SW setting complete” is printed, power 
may be turned off.

Note: All eight switches in SW-1 must bet set to ‘on’ or ‘off’ before 
exiting.
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Figure 14. DIP Switch Settings for Printer
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Computer Operation

About the Software

The Radon Monitor uses a Windows program called “1028/1029 Radon Monitor.” 
The software can be used to: 

• Enter and download setup parameters into the radon monitor

• Upload report data from the radon monitor into the computer

• Add customer information and test conditions to the report

• Print reports on any available printer

Set Up Software

Prerequisites
• Ensure the computer meets the system requirements in Recommended 

System Requirements on page 46.
• Administrative rights may be required to install and use the software, and to 

set up communication between the computer and the Radon Monitor.

Install Software

1 Download the 1028/1029 Radon Monitor software from the Radon Support 
website, https://support.sunnuclear.com/radon/ and save it to your computer 
or laptop.

2 Right-click the software executable file Setup.exe and select Run as 
Administrator, then follow the on-screen instructions to install the software. 
Accept all default folders and file locations.

3 When the ‘Device Driver Installation Wizard’ is displayed, click Next. The 
device drivers are installed and then the driver status (‘Ready to use’) is 
displayed.

4 Click Finish to close the window. The ‘Installation Completed’ window is 
displayed.

5 Click Finish to close the ‘Installation Completed’ window. The Radon Monitor 
icon appears on the desktop.

Note: USB drivers are installed automatically during this procedure.
26
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Connecting to Computer

The radon monitor can be connected to a computer using the USB cable provided 
with the radon monitor. 

If the computer does not have a USB port, a serial cable can be used to connect 
the radon monitor to the computer. See Optional Serial Connection on page 50.

1 Ensure that the radon monitor software has been installed on the computer. 

2 Connect the USB cable to the computer and the radon monitor (Figure 15). 

Figure 15. USB Connection to a Computer

3 If desired, plug the power supply cord into a 100 to 240 VAC, 1-phase, 50-60 
Hz mains power source. 

Launch Software

1 Ensure that the radon monitor is connected to the computer via a USB or 
serial cable.

2 Launch the software application by double-clicking the Radon Monitor 
desktop shortcut  or by selecting Start > Programs > SNC Group > 

Radon Monitor.

3 If the ‘Select Port’ window is displayed, select the port and then save it. See 
Port Selection on page 51.

Note: If the software does not detect the port, select it manually by 
selecting Setup > Select Serial Port from the on-screen menu. See 
Serial Port Setup on page 50.
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Using Software to Retrieve Data
1 After launching the software, turn on the radon monitor by pressing the ON 

key (5).

2 If prompted, enter the PIN and press 5.

3 When the display shows “Start Test = 5”, click the Retrieve Data from 
Monitor button at the bottom of the Inspection tab on the main screen. The 
connection is maintained until software is closed.

USB Cable Connection/Disconnection

If the USB cable is connected after software is already launched, the computer 
will detect the port and display a message (Figure 16). Click Yes to connect. A 
similar message appears if the cable is disconnected while software is running.

Figure 16. Port Detection Message

Closing Software

To close the radon monitor software, click the Close button in the Inspection tab 
or select File > Exit from the menu.
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About the Main Screen

The main screen has a menu bar, toolbar buttons, a status bar, and four tabs 
(Inspection, Chart, Pictures, and Checklist). The toolbar and status bar can be 
displayed, as shown below, or hidden.

The appearance of the main screen will change depending on the tab that is 
selected.

Figure 17. Main Screen, Inspection Tab Shown

Main Screen - Inspection Tab

The Inspection tab (Figure 18 on page 30) shows:

• Information about the Radon Monitor.

• Test parameters

• Customer information

• Inspection company information

• Radon risk information (EPA information about Radon)

• Testing protocols (information to help interpret test results)

• A list of documents that the inspector can provide to the homeowner

Menu bar Toolbar (if 
displayed)

Tabs

Status bar 
(if displayed)
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Group Item Description
Continuous 
Radon Moni-
tor (from 
factory)

Model Number Model number, 1028 or 1029.

Serial Number Serial number of this unit.

CF Calibration factor—determined during calibration.

Battery Battery voltage.

Calibration Date Date the unit was last calibrated.

Test Parame-
ters (from 
monitor)

Start Time Time the test started.

Hours Delayed Time delay before starting test.

Test Duration Length of the test in hours.

Measurement 
Interval

Hourly interval between measurements.

Number of 
Measurements

Total number of measurements in this test.

Overall Average Average radon level detected during the entire test.

EPA Average The average radon level detected during the dura-
tion of the test minus the first 4 hours. Removing 
the first 4 hours permits the test environment to 
stabilize.

Figure 18. Inspection Tab Details
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Customer 
Information

(usually 
entered after 
retrieving test 
data from the 
monitor)

Name Enter customer name to appear on printed report.

Address 1 Enter address line 1.

Address 2 Enter address line 2 (if applicable).

City Enter city.

State/Province Enter state or province.

Zip Enter zip or postal code.

Phone Number Enter phone number.

Double arrow button  If Site Address and Billing Address are the same, 
click the double arrow to copy the information. 

Inspection 
Company

N/A The “Inspection Company” information is entered in 
the Monitor Settings tab in the Preferences screen. 
See Monitor Settings Preferences on page 38.

Radon Risk 
Information

Radon risk information (EPA information about 
Radon). This information can also be included in the 
printed report. See Report Printing Preferences on 
page 40.

Understand-
ing Time 
Sensitive 
Testing 
Protocols

Testing protocols (information to help the inspector 
interpret test results). This information can also be 
included in the printed report. See Report Printing 
Preferences on page 40.

Documents 
Provided

A list of documents that the inspector can provide to 
the homeowner. These documents are copied to the 
computer during the Radon software installation, 
and are saved in the 
C:\Program Files\SNC\Radon10281029\Radon-
Documents directory.

Retrieve Data 
From Moni-
tor button

Retrieves data from the connected radon monitor. 
This function can also be performed from the Moni-
tor Settings tab.

Clear Screen 
button

Clears all data from the left side of the Inspection 
tab (monitor information, test parameters, customer 
information, inspection company information). This 
provides a visual cue that all data has been cleared 
from the software and that new data is downloaded 
when the user clicks the ‘Retrieve Data from Moni-
tor’ button.

Close button Closes the Radon Monitor software program.

Group Item Description

Figure 18. Inspection Tab Details (Continued)
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Main Screen - Chart Tab

The Chart tab shows a chart (graph) of the test results (Figure 19). The graph is 
included in the printed report.

Group Item Description

Chart Chart Title The chart title includes the model number and serial num-
ber of the radon monitor.

Left vertical scale The left vertical scale of the chart shows the Radon con-
centration in the units selected, pCi/l or Bq/m3.

Right vertical 
scale

(Model 1029 only; for Model 1028 the right vertical scale 
is blank). The right vertical scale is for temperature, pres-
sure, and % humidity. The units for temperature and 
pressure are the units selected.

Horizontal scale The horizontal scale shows the date in one-day 
increments.

Radon (units) 
graph

If checked in the Legend Panel, the Radon graph line con-
nects the values of the periodic measurements during 
the test. The overall average (or EPA average) is displayed 
above the Legend panel.

Figure 19. Chart (Graph) Details
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Zooming In and Out
• To zoom in on the chart, drag a bounding box down and to the right around 

the area to be examined more closely. When the mouse button is released 
the view will zoom in to the selected area.

• To zoom out, drag the cursor up and to the left. The original view is restored.

Moving the Chart
• To move the chart on the page, position the cursor over the chart, press and 

hold the right mouse button, and then move the mouse.

• To restore the original view, position the cursor over the chart, click the left 
mouse button, and then drag the cursor up and to the left.

Chart 
(Continued)

Motion Errors If checked in the Legend Panel, and if motion was 
detected during the test, a vertical line with a red circle 
indicates each motion event. Also, the text ‘Motion 
Detected’ is displayed above the Legend Panel.

Action Level If checked in the Legend Panel, the Action Level horizon-
tal, red line is displayed. The line will be drawn on the 
graph at the selected radon concentration above which 
mitigation action is necessary. Normally the level is 
4 pCi/l or 148 Bq/m3.

When the radon level line does not exceed the action 
level, the action level line is always visible on the chart for 
easy comparison.

Temp (units) (Model 1029 only) If checked in the Legend Panel, tem-
perature recorded during the test is shown as a red 
dotted line. The average temperature is displayed above 
the Legend Panel.

Pressure (units) (Model 1029 only) If checked in the Legend Panel, the 
pressure recorded during the test is shown as a dotted 
green line. The average pressure is displayed above the 
Legend Panel.

Rel % Humidity (Model 1029 only) If checked in the Legend Panel, the 
percent relative humidity recorded during the test is 
shown as a blue dotted line. The average relative humid-
ity is displayed above the Legend Panel.

Legend 
Panel

Radon (units) Select this checkbox to display the Radon graph line.

Motion Errors Select this checkbox to display vertical Motion Error 
line(s).

Action Level Select this checkbox to display the horizontal, red Action 
Level graph line.

Temp (units) (Model 1029 only) Select this checkbox to display the 
Temperature graph line.

Pressure (units) (Model 1029 only) Select this checkbox to display the 
Pressure graph line.

Rel % Humidity (Model 1029 only) Select this checkbox to display the Rel-
ative Humidity graph line.

Group Item Description

Figure 19. Chart (Graph) Details (Continued)
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Main Screen - Pictures Tab

The Pictures tab is used to select up to six pictures that can be printed in the 
report. The pictures may consist of setup photos, before and after, etc.

The Print Picture checkbox above each picture allows the user to select which 
images will be displayed in the report. The selected images are displayed on the 
last page of the report, except for the top, left image (labeled ‘Cover Page 
Picture’), which can be displayed on the cover page as well as the last page of the 
report. Note that the report will only contain a cover page if the ‘Create Cover 
Page’ checkbox is selected in the Preferences ‘Print Tab’ screen.

A title or comment may be entered in the Comments box below each picture (up 
to 50 characters). If the ‘Print Picture’ checkbox is selected, both the picture and 
comment are printed in the report. If the Comments box is blank, no comment 
will be included with this picture in the report.

The Select Picture button below each picture is used to browse to the directory 
where pictures are stored and select a picture.

Figure 20. Main Screen - Pictures Tab
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Main Screen - Checklist Tab

The Checklist tab provides a checklist that the inspector can use to verify that 
best practice actions were completed prior to starting the test (such as locating 
the radon monitor where it will not be disturbed, not locating it near drafts, etc.).

Figure 21. Main Screen, Checklist Tab
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Menu Bar and Toolbar Functions

The menu bar contains commands for operating the program. The toolbar (if 
displayed) is just beneath it. All of the toolbar commands can also be selected 
from the menu.
 

Group Item Description

File Retrieve Data Retrieves data from the connected radon monitor.

Save Measured 
Data

Allows measured data to be saved in text (.txt) format. This 
menu command has the same function as the Save toolbar 
button.

Open Measured 
Data

Opens a previously saved text file with measured data. This 
menu command has the same function as the Open toolbar 
button.

Print > Test 
Results

Prints the selected test results to the default system printer. 
This menu command has the same function as the Print tool-
bar button.

Print Preview Opens a preview window to view the report to be printed. 
From the preview window, the user can scroll through a 
multi-page report, print it, or print the report to a PDF file.This 
menu command has the same function as the Print Preview 
toolbar button.

Print Setup Opens the Windows printer setup dialog box to change 
printers or printer characteristics.

Exit Exits the radon monitor program.

Edit Copy Raw Data Copies raw test data to the Windows clipboard. Then the 
data can be pasted into another application, such as a word 
processor or spreadsheet.This menu command has the 
same function as the Copy Data toolbar button.

Copy Chart Copies the chart for the test to the Windows clipboard. Then 
the chart can be pasted into another application, such as a 
word processor or spreadsheet. This menu command has 
the same function as the Copy Chart toolbar button.

Write Raw Data Writes raw test data to a text (.txt) file that can be opened 
with a text editor, spreadsheet, or word processor. Raw data 
does not contain file header information, such as customer 
name, etc. This menu command has the same function as 
the Write Into File toolbar button.

Figure 22. Menu Bar Commands
36



Data to/from Text File

Save Data to File

1 Retrieve data from the monitor.

2 Click the Save toolbar button or select File > Save Measured Data from the 
menu.

3 When the ‘Save As’ window is displayed, browse to the directory where the 
file will be saved, enter a file name, and then click Save.

Open Data from File

1 Launch the monitor software and then click the Open toolbar button or 
select File > Open Measured Data from the menu.

2 When the ‘Load Measured Data’ window is displayed, navigate to the 
directory where the text files are stored, select the desired file, and then click 
Open. The data is populated on the screen.

View Toolbar When checked, displays the toolbar below the menu.

Toolbar Label When checked, displays labels beneath the tools on the 
toolbar.

Status Bar When checked, displays the status bar at the bottom of the 
main screen.

View Notices Displays a screen that can be used to show all notices from 
the monitor, clear notices, or save notices to a log.

Setup Monitor Settings Displays the ‘Preferences’ screen with the Monitor Settings 
tab selected. This tab is used to update information about 
the Inspection Company or the radon monitor. Note that 
monitor data must be cleared before updating monitor infor-
mation. For details, see Preferences Screen - Monitor 
Settings Tab Details on page 39. This menu command has 
the same function as the Monitor Settings toolbar button.

Print Preferences Displays the ‘Print Preferences’ screen with the Print tab 
selected so the user can update print preferences. For 
details, see Report Printing Preferences on page 40. This 
menu command has the same function as the Print Prefer-
ences toolbar button.

Select Serial Port Opens a ‘Select Port’ dialog box to select the COM port num-
ber for connection to the radon monitor. This menu 
command has the same function as the Select Serial Port 
toolbar button.

Help Contents Opens the on-line help viewer.

About Displays information about the program including version 
number.

Group Item Description

Figure 22. Menu Bar Commands (Continued)
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Monitor Settings Preferences

The software can be used to send basic parameters to the radon monitor. 
Although this can also be done using the keypad on the radon monitor, it may be 
quicker and easier to perform from the software, especially when several radon 
monitors are being updated.

1 Connect the radon monitor to the computer and launch the software. 

2 Turn on the radon monitor display by pressing the ON button (5).

3 When the display shows “Start Test = 5,” click the Monitor Settings button 
in the toolbar or select Setup > Monitor Settings from the menu. The 
‘Preferences’ screen opens with the Monitor Settings tab options displayed.

Figure 23. Monitor Settings

4 In the Monitor Settings tab, click the Retrieve Data From Radon Monitor 
button to retrieve the data stored in the radon monitor.

Note: Some test parameters, such as Delay, Test Duration, and 
Measurement Interval, can only be changed on the radon monitor. 

Note: A pop-up window warns if there is data in memory. The Monitor 
Settings options cannot be edited if there is data in memory. 
38



5 Edit the Inspection Company and Radon Monitor information, as needed. For 
details about the screen options, see Preferences Screen - Monitor Settings 
Tab Details on page 39.

6 Set the date, time, pin number and Radon units. If the Set Monitor Time 
checkbox is selected, the software automatically updates the time and date 
to the computer’s system clock.

7 Click the Send Data to Monitor button. The changed parameters are stored 
in the radon monitor’s internal memory.

Preferences Screen - Monitor Settings Tab Details
The Monitor Settings tab is used to enter details that will be transferred to the 
radon monitor’s memory. 
 

Group Item Description
Retrieve Data 
from Monitor 
button

N/A When Start Test = 5 is displayed on the monitor, click 
this button to retrieve the parameters and test results 
stored in the radon monitor. 

Note that radon monitor data cannot be updated if 
there is test data in memory.

Figure 24. Monitor Settings Tab Details
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Report Printing Preferences

1 Connect the radon monitor to the computer and launch the software. 

2 Turn on the radon monitor by pressing the ON button (5).

3 When the display shows “Start Test = 5,” click the Print Preferences button 
in the toolbar or select Setup > Print Preferences from the menu. The 
‘Preferences’ screen opens with the Print tab displayed.

4 Select or enter the desired information. For details about the Print Tab 
options, see Preferences Screen – Print Tab Details on page 42.

Inspection 
Company

Name Enter inspector name for the report.

Company Name Enter the name of the inspection company.

Address 1 Enter the inspection company’s address line 1.

Address 2 Enter the inspection company’s address line 2.

City Enter the city.

State/Province Enter the state or province.

Postal Enter the zip.

Phone Number Enter the inspection company’s telephone number.

License Number Enter the inspection company’s radon inspection 
license number. The field allows up to 100 characters. 
The separator character (between license numbers), 
can be a comma, dash, period, or any other character.

Radon Monitor Date/Time Date and time of the radon monitor’s clock when 
retrieve button is pressed. Time is not continuously 
updated.

Set Monitor Time Click checkbox to set monitor time to be the same as 
the computer’s system time.

PIN Enter a PIN number if desired. Pin numbers are 4 digits 
ranging from 1112 to 4444. PIN 1111 is the same as 
“no PIN.” PIN entry must be followed by entering “5.”

Radon Units Select radon units from the drop-down list. Units are:
• picocuries per liter (pCi/l) (English units), or 
• becquerels per cubic meter (Bq/m3) (metric units). 

Pressure units (Model 1029 only) Units of pressure selected automat-
ically depending on whether metric or English radon 
units are selected.
• metric = kilo Pascals (kPa)
• English = inches of mercury (inHg)

Temperature 
units

(Model 1029 only) Units of temperature selected auto-
matically depending on whether metric or English 
radon units are selected.
• metric = degrees Celsius (centigrade)
• English = degrees Fahrenheit

Serial number Factory set unit serial number.

Firmware version Version number of the firmware.

Send Data to 
Monitor button

Sends updated parameters to the Radon Monitor.

Group Item Description

Figure 24. Monitor Settings Tab Details (Continued)
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5 If the report will be printed on company letterhead, select the amount of 
space that should be left at the top of the paper so the report does not 
overprint the letterhead.

6 Select whether the report displays EPA Average, Overall Average, or both.

7 If a signature image file is available, select it. The signature image is 
displayed on the last page of the printed report, above the ‘Signature’ line.

a. Click the file folder button ; the file selection window appears.

b. Browse to the directory where the pictures are stored.
c. Click on a picture (.gif, .bmp, or .jpg.) to highlight it.

• The image is displayed on the right side of the screen and the image 
size is displayed in the upper right of the screen.

• The preferred image size for the signature file is 200 x 60 or smaller 
(width=200 pixels, height=60 pixels). The preferred image size for 
the header image is 250 x 60 or smaller (width=250 pixels, 
height=60 pixels). Any size can be used and the image will be 
scaled; however some distortion may occur if the image does not 
have the same aspect ratio.

d. Click the Open button.

8 If a header image file is available, select it (see the signature image substeps 
above). The header image will be displayed on the first page of the report (not 
the cover page or other report pages).

9 The Chart Action Level setting draws a line on the graph to show where the 
radon level exceeds the local standard and requires the owner to take 
remediation action.

• If the units are picocuries/liter (pCi/l), set the action level required in your 
region. For example, USA action level for pCi/l is 4.

• If the units are Bq/m3, set the action level required in your region. For 
example, USA action level for Bq/m3 is 148.

• Units can be converted by multiplying pCi/l x 37 = Bq/m3; for example, 
4pCi/l x 37 = 148 Bq/m3.
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Preferences Screen – Print Tab Details
The ‘Print Preferences’ screen Print tab is used to select options for the printed 
report. If a checkbox is selected, the information is included in the report.
 

Group Item Default 
Value Description

Printing 
Preferences

Atmospheric 
Conditions

Selected 
(checked)

Select atmospheric conditions at test site 
from drop-down list.

Wind 
Direction/Speed

Selected 
(checked)

Select wind direction and speed at test site 
from drop-down list.

Year Built Selected 
(checked)

Year construction was completed.

Sq. Ft. Selected 
(checked)

Approximate area of the room that was 
monitored.

Structure Type Selected 
(checked)

Type of construction or other descriptive 
information.

Monitor Location Selected 
(checked)

Location of the radon monitor in the house, 
building, or mine.

Letter Head 
Space

0.00 inches Extra space in inches to be added at the 
top of a report to provide room for inspec-
tor’s preprinted letterhead.

Figure 25. Print Tab Details
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Printing Pref-
erences 
(Continued)

Select Signature 
Image

Blank If selected, the signature image will appear 
on the last page of the report above the 
‘Inspector Signature’ line. The header 
image will appear at the top of the first 
page of the report (not the cover page or 
other report pages). Use the Print Preview 
function to see the image and verify 
alignment.

Select Header 
Image

Blank

File Folder 
button 

N/A Opens a file selection window so the user 
can browse to and select the file. The right 
panel of the file selection window displays 
the selected image and the image size.

Clear Image 
button 

N/A Clears the image selection.

Header Image 
Alignment

Center 
Aligned

Select if the header image will be left-
aligned, center-aligned, or right-aligned.

Create Cover 
Page

Not 
Selected 
(unchecked)

Selecting this checkbox adds a cover page 
to the printed report and prints the image 
selected in the ‘Cover Page Picture’ box in 
the Pictures tab. See Main Screen - Pictures 
Tab on page 34.

The cover page will also display the site 
address, inspection date, inspection com-
pany information, and inspector license 
number.

Print Signature on 
First Page

Not 
Selected 
(unchecked)

Certain US states, such as Ohio, require 
the inspector’s signature to appear on the 
first page of the report. If this is require-
ment in the local inspection area, select 
this checkbox. An Inspector Signature is 
added to the first page of the report (not 
the cover page).

Print EPA Average Selected 
(checked)

Print the EPA Average radon concentration 
on the printed report.

Print Overall 
Average

Selected 
(checked)

Print the Overall Average radon concentra-
tion average on the printed report.

Print Radon Risk 
Information

Not 
Selected 
(unchecked)

If selected, the Radon Risk Information 
(from the Inspection tab) is printed in the 
report.

Print Understand-
ing Testing 
Protocols

Not 
Selected 
(unchecked)

If selected, the Understanding Testing Pro-
tocols information (from the Inspection 
tab) is printed in the report.

Mitigation Sys-
tem Installed

Not 
Selected 
(unchecked)

Select this checkbox if a Radon mitigation 
system was installed at the site. If checked, 
the report will show that a Radon mitiga-
tion system was installed.

Mitigation Sys-
tem Working 
Properly

N/A If the Mitigation System Installed checkbox 
is selected, choose the appropriate radio 
button to note whether the mitigation sys-
tem was “Installed and working properly” 
or “Installed but not working properly.”

Group Item Default 
Value Description

Figure 25. Print Tab Details (Continued)
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Printing Reports

1 To print a standard, formatted report, open the Radon Monitor software, 
retrieve data from the monitor, and then click File > Print > Test Results. A 
formatted report is printed on the default printer (Figure 26). The first page of 
the report will display the same graph as the Chart tab.

Figure 26. Printed Report (First Page)

2 To see a preview of the report before printing, click the Print Preview toolbar 
button or select File > Print Preview from the menu. From the ‘Print 

General 
Preferences

Chart Action 
Level

4.00 pCi/l Enter the action level required by the coun-
try or state for the maximum allowable 
level of Radon concentration before mitiga-
tion action is required. See Step 9 in Report 
Printing Preferences on page 40.

The Action Level appears as a red, horizon-
tal line on the graph.

Display Average 
Data on Chart

Not 
Selected 
(unchecked)

If this checkbox is selected, the Overall 
Average (or EPA Average) is displayed in 
the Chart tab above the Legend panel.

Group Item Default 
Value Description

Figure 25. Print Tab Details (Continued)

Continuous Radon Monitor
Model Number: 1029 Serial Number: 4778405

Calibration Date: 01/10/2009 CF: 2.57, 2.57

Monitor Time: 1/8/2010 8:47

Inspection Company Billing Information Site Information
Sun Nuclear Corp

425 A Pineda Court

Test

Melbourne, FL-32940

Phone Number: 3212596862

License Number: 1234, 5678

Site & Condition
Wind: NA Atmospheric Condition: NA

Year Built: NA Structure Type: NA

Mitigation System: Not Installed Monitor Location: NA

SqFt: NA

Test Summary
Start Time: 12/15/2009 16:53 Overall Avg: 0.6 pCi/l

End Time: 12/17/2009 09:53 EPA Avg: 0.6 pCi/l

Measurement Interval(hr): 1.0

Exposure Time: 1 Days  17 hrs

1
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Preview’ window, the user can print the report, save it to a PDF file, or view 
it page-by-page by clicking the buttons at the top of the screen (Figure 27).

Figure 27. Print Preview Screen

3 To save the report as an Adobe PDF file, open the ‘Print Preview’ window 
then click the Print to PDF button at the top of the screen. In the file window, 
select a file name and directory where the file will be stored. Click Save.

4 To change the printer or printer setup, click File > Print Setup. The standard 
Windows printer dialog box opens.

5 To extract data to insert it in a report, use one of the following options:

• Click the Copy Data toolbar button or select Edit > Copy Raw Data 
from the menu. The current data is copied to the Windows clipboard and 
can be pasted into another application, such as MS Word or MS Excel.

• Click the Copy Chart toolbar button or select Edit > Copy Chart from 
the menu. The current chart is copied to the Windows clipboard and can 
be pasted into another application, such as MS Word or MS Excel.

• Click the Write Into File toolbar button or select Edit > Write Raw Data 
from the menu. The raw data is saved to a text (.txt) file. Raw data does 
not contain header data, such as customer information. The saved text 
file can be opened in any program that supports .txt files.
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Specifications

Recommended System Requirements

Models 1028 and 1029 Specifications

Characteristic Details
Operating System Windows 8.1, Windows 7, or Windows XP (32-bit or 64-bit)

Note: Windows XP is not recommended since Microsoft no lon-
ger supports it.

Computer Minimum
• Processor: x486
• Total RAM: 128 MB
• Disk space: 10 MB
• USB port: one 
• Display resolution: 1024 x 768
• Color depth: 32-bit

Description Value

Measurement Range 0.1 to 9999 picocuries/liter (pCi/l) or 1 becquerels per cubic meter 
(Bq/m3) to 99.99 kilo becquerels per cubic meter (kBq/m3)

Accuracy ±25% or 1 pCi/l, whichever is greater after 24 hours

Detector Diffused-junction photodiode
• Model 1028—quantity 1
• Model 1029—quantity 2

Active volume—9.4 cm3

Dome volume—63 cm3

Measurement Interval 0.5 (1029 only), 1, 2, 4, 8, 12, 16, 20 or 24-hour intervals, select-
able by user

Test Duration 1, 12, 24, 36, 48, 60, 72, 84, 96, 100, 999 hours, selectable by 
user (maximum of 720 measurements)

If 999 is selected, measures until memory is full or to 720 data 
points, whichever occurs first

Sensitivity • 1028—3 counts per hour per picocurie per liter (cph/pCi/l)
• 1029—6 counts per hour per picocurie per liter (cph/pCi/l)

Display 16-digit reflective LCD display

Status Light Green LED (light emitting diode) indicates radon detections

Keypad 6-digit membrane switches with multiple functions

Disturbance Sensor Inertial switch

Environmental sensors 
(1029 only)

• Temperature—0 to 120 ± 2 degrees F
• Pressure—10 to 15 ± 0.5 psi
• Humidity—20 to 90% relative humidity ± 5%

Operating Environment • 45 to 95° F (7 to 35° C) 
• 20 to 80% relative humidity, non-condensing

Table 2. Models 1028 and 1029 Technical Specifications
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Storage Environment • –22 to 122° F (–30 to 50° C)
• 10 to 90% relative humidity, non-condensing

Printer Data Port RS-232, 9-pin, D-connector allows printer data to be sent to 
optional thermal printer

Serial Data Port RS-232, 9-pin, D-connector for two-way communication with PC

USB Data Port USB-A connector allows two-way communication with PC

Power Supply • Domestic: Transformer converts 120 VAC to 12 VDC, 
200 mA, 60 Hz

• International: Transformer converts 100-240 VAC to 18 VDC, 1 
A, 50-60 Hz

Battery Power/Backup One fresh 9V alkaline battery usually supplies approximately 100 
hours of operation while a fresh lithium-ion battery usually sup-
plies approximately 300 hours of operation. “Battery OK” 
message indicates battery OK for 60 hours of operation.

Tripod threaded fitting Standard 1/4-20 UNC threaded fitting on bottom of case

Handle Integrated handle for carrying or for use with cable lock

Weight 2 lbs (0.91 kg)

Dimensions 9.3W x 4.8D x 2.9H inches (236 x 122 x 74 mm)

Description Value

Table 2. Models 1028 and 1029 Technical Specifications (Continued)
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Support and Maintenance

Maintaining Hardware

Repairs

If there are problems with the device, contact Sun Nuclear Support. See 
Contacting Sun Nuclear Support on page 54.

Inspection
Inspect the device and all cables for physical damage before and after each use. 
Do not use any cable that is damaged or has broken insulation. Replace the cable 
immediately. If any device damage, mechanical or electrical degradation, or 
measurement errors are suspected, contact Sun Nuclear Corporation for repair or 
replacement.

Storage

Store the radon monitor in an indoor, protected environment. Do not store the 
radon monitor in the trunk of a car for extended periods. Keep the unit dry. For 
long term storage, store in a cool, dry place and leave a 9V battery in the unit to 
protect the internal battery. Periodically inspect the 9V battery and replace if 
leakage or corrosion are found.

See also Storage Under Power on page 16.

Cleaning
Clean the unit with a soft dry cloth. Do not use liquid cleaners, solvents, or 
abrasives.

Disposing and Recycling
Do not discard unit as waste. Recycle the components in accordance with local 
regulations.

WARNING: The unit contains high-voltage circuits. Do not open the 
case. There are no user-serviceable parts inside the device.

CAUTION: Always leave a fresh 9V battery in the unit to keep the 3V inter-
nal battery from discharging. 

Do not throw in trash; dispose of in an environmentally friendly way.
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Service and Calibration
For service or calibration, the unit must be returned to Sun Nuclear Corporation. 
The recommended calibration frequency for the Model 1028 or 1029 radon 
monitor is one year. See your State or Proficiency listings for requirements.

Battery Life
Any 9V battery will operate the radon monitor. Alkaline batteries generally provide 
a good balance between long life and cost; lithium-ion batteries tend to be more 
expensive but last longer. Since battery capacity varies widely between types of 
batteries and even between individual batteries of the same type, the predicted 
battery life of 100 hours using a fresh alkaline battery (or 300 hours using a fresh 
lithium-ion battery) is only an estimate. An individual unit may have longer or 
shorter life.

Maintaining Software

The radon monitor has Windows software that is installed on a computer. 
Software upgrades or patches may become available after purchase; these 
changes to the software add features, improve operation, fix problems, or adapt 
to operating system changes.

These upgrades, when available, can be downloaded from the Sun Nuclear 
Support website for Radon products (see Support Website on page 54). Navigate 
to “Support,” then select “Radon Downloads.”

Verifying Software Version
The version of software may be verified as follows:

1 Launch the Radon Monitor application. 

2 Connect to the radon monitor.

3 Select Help > About from the menu. The About Radon Monitor message 
displays the version number of the application.

Removing Software
To remove the radon monitor software from the computer, open the Control 
Panel and then select Add or Remove Programs. In the list of programs, select 
Radon Monitor and then click Remove. This will remove all of the radon monitor 
program files.

Multiple Software Installations

Two or More Radon Monitor Units

The Radon Monitor software only needs to be installed on a computer one time, 
regardless of the number of radon monitor units being used with that computer. 

When connecting to a radon monitor, the software identifies the serial number of 
the connected radon monitor and creates a unique serial number directory for 
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each radon monitor device. During measurement, the setup template includes 
the serial number, which is validated against the radon monitor device 
communicating data to the PC. 

Two or More Computers

If you have more than one computer, the radon monitor software may be installed 
on each one.

Optional Serial Connection

Serial Port Setup
Serial or USB port setup is automatic, unless there is a hardware conflict. When 
the radon monitor software is launched and the monitor is plugged in, the 
software automatically detects the unit on an available COM port. If the software 
does not detect the radon monitor automatically, it may be necessary to select a 
specific port.

Connecting with a Serial Cable
If the computer does not have a USB port, the radon monitor can be connected 
using a serial cable as follows:

1 Connect an optional serial cable between the computers 9-pin COM port and 
the 9-pin PC PORT connector on the radon monitor (Figure 28 on page 50). 
For serial cable part number, see Options and Accessories on page 2. Serial 
cable can also be used with optional printer.

2 If desired, plug the power supply into an AC outlet with 110 to 240 VAC, 
single phase, 50-60 Hz. 

Figure 28. Optional Serial Connection to a Computer
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Port Selection
Normally the software tries to connect to the radon monitor on COM 1. But if 
COM 1 is in use, select another COM port as follows:

1 Click the Select Serial Port toolbar button or select Setup > Serial Port from 
the menu. The ‘Setup Port’ dialog box opens.

Figure 29. Setup Port Dialog Box

2 Click the Ports drop-down list then select the desired port (usually the last 
port in the list).

3 Click Save. When the program is opened again, the selected COM port will 
be used. 

Radon Monitor Troubleshooting

Indication Probable Cause Recommended Action

Unit will not turn on Power not connected and 9V 
battery missing or 
discharged.

Connect power and/or 
replace 9V battery.

Unit will not turn on with 
power or good battery 
connected

Internal 3V battery 
discharged. 

Contact Sun Nuclear Support. 
Unit will need to be returned 
for internal battery replace-
ment. The user should not 
attempt to replace this 
battery.

Time/Date entries lost 
when changing battery

Reset occurred. Re-enter settings.

System error message in 
format “ERR=XX XX XX XX” 
displayed

Monitor has experienced an 
abnormal condition.

See ERR Message on 
page 52.

Error message “RS232 
communications have 
been lost“ when trying to 
connect to PC

Radon monitor is turned off or 
has turned off automatically.

Turn on radon monitor by 
pressing “5” and entering PIN 
and pressing “5” again.

Wrong COM port selected for 
serial or USB connection.

Click Setup > Select Serial Port. 
Select a different COM port 
from the pull-down list.

Error message “Notice: 
Press 5” displayed

Monitor has experienced an 
abnormal condition.

See Notice Message on 
page 52.
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System Errors

ERR Message

If an error message appears on the display in the format “ERR=XX XX XX XX,” the 
radon monitor experienced an unusual system error. Normally this indicates a 
hardware or firmware failure. Make a note of the 8-digit error code and contact a 
Sun Nuclear Support representative for assistance.

Notice Message

If the message “NOTICE: Press 5” appears in the display upon waking up, there 
has been an error. 

1 To read the error, press 5. The display:

• Briefly displays “ERROR Stopping Test” 

• Then displays “Read using PC”

• Then displays “Start Test = 5”

However, the error condition has not been cleared.

Display showed “Motion 
Detected” but motion not 
recorded on report

Test interrupted before being 
completed. Motion occurred 
as test was terminated.

Print results and count num-
ber of measurements. If less 
than expected, test termi-
nated prematurely. Rerun 
test.

Monitor displays an AVER-
AGE value, but no 
CURRENT value

The monitor lost power 
recently, which cleared the 
CURRENT value. However the 
AVERAGE is maintained. 

Run test with a fresh 9V 
battery.

Hourly readings on the 
radon monitor always 
seem to show the same 
numbers (such as 0.0, 0.3, 
0.7, etc.), especially at 
lower radon levels; values 
between lower numbers 
are not measured

At very low radon levels, only 
1, 2, or even 0 (zero) radon-
emitted alpha particles may 
be detected in an hour 
interval. 

The one-detector SNC radon 
monitor, such as a model 
1027 or 1028, has a sensitivity 
roughly in the range of 3.0 
counts per hour per pCi/L 
(check the unit’s calibration 
factor for the actual number). 
If only one count is detected 
in an hour, the monitor has 
measured 1 cph / 3.0 cph per 
pCi/L is equal to  0.3333 pCi/L, 
which rounds to 0.3. Two 
counts would be 0.6666 
pCi/L, which rounds to 0.7. 

Device working normally, no 
need for action.

By performing radon mea-
surements over a longer 
period of time, such as 48 
hours, the average of discrete 
hourly measurements is capa-
ble of measuring any value, 
even at low radon levels. 

For example, a radon level of 
0.5 pCi/L measured over 48 
hours might have individual 
hourly measurements of 0.0, 
0.3, 0.7, or 1.2, but the aver-
age of all 48 hourly 
measurements would still 
read 0.5 pCi/L.

Note: Firmware version 0102 can cause a data error of 00 00 00 40 
when attempting to print a report with a graph when no data is in the 
radon monitor. If this occurs, please call Sun Nuclear Support. See 
Contacting Sun Nuclear Support on page 54.

Indication Probable Cause Recommended Action
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2 Connect device to computer and launch Radon Monitor application.

3 On the menu, click Com Port and verify the correct Com port is selected.

4 Select View > View Notices, then Read Notices from Monitor. Make note 
of the error explanation that displays on screen. This information may be 
useful to Sun Nuclear Support.

5 Select Save to Log and save the error code text to a log file.

6 Select Clear Notices from Monitor to remove the error code from the 
device.

7 Download measurement data and continue with test.

8 If error condition continues, an error message appears again after the test 
and must be cleared again. If this occurs, device likely requires service. See 
Contacting Sun Nuclear Support on page 54.
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Contacting Sun Nuclear Support

Visit the Sun Nuclear Radon website, https://support.sunnuclear.com/radon/ for 
links to product information, including instructional videos and Radon FAQs, 
Calibration and Repair services, online RMA form, Support, Downloads and 
useful links. 

To view product information or to download product assets, click the links under 
Radon Downloads. 

If you need additional assistance, you may request support in two ways:
• Customers without a current support/maintenance agreement can submit a 

support request using our online form, or visit our FAQ’s page on the same 
website, https://support.sunnuclear.com/radon.

• Customers with a current support/maintenance agreement also have the 
option to contact the Sun Nuclear Support team by telephone:
+1 321-259-6862.

Support Website
Visit the Sun Nuclear Support website to request support via an online form.

1 Open an internet browser and navigate to 
https://support.sunnuclear.com/radon.

2 In the left panel, click Contact Support.

3 To open a new support case, click the New Case form link, enter your email 
address and the serial number of any Sun Nuclear instrument used at your 
facility, then click Log in to open the Support Dashboard.

Warranty

The Sun Nuclear Product Warranty can be found on the Sun Nuclear Radon 
Support website, https://support.sunnuclear.com/radon/. 
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Appendix A: Regulatory Supplement

In addition to the regulatory information contained in the body of this manual, the 
following supplemental regulatory information is provided.

Sun Nuclear Corporation Symbols

The following symbols are used in this guide and in Sun Nuclear Corporation’s 
product labels.

WARNING:  This symbol indicates a risk of electric shock.

WARNING:  This symbol indicates a hazard that could result in major 
injury or equipment damage.

CAUTION: This symbol indicates a potential hazard that could result in a 
minor injury or equipment damage.

Important or supporting information.

Manufacturer’s Identification (name and address).

Date of Manufacture.

Serial Number.

Catalog Number.

Consult instructions for use. This equipment must be used in 
accordance with the instructions in this manual. Read all instructions 
and safety labels before use.

Do not throw in trash; dispose of in an environmentally friendly way.
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Operator Responsibility

This guide is intended for an operator who is experienced with the use of radon 
detection devices. The operator of the device bears the full responsibility for 
validating measurement results. The device and its accessories must not be used 
for any other purpose than described in this guide. Violation will result in loss of 
warranty.

Reporting Health or Safety Related Issues or Concerns

Should the need arise to report any safety or health related issues or concerns 
regarding the use of Sun Nuclear products, contact Sun Nuclear Support. See 
Contacting Sun Nuclear Support on page 54.

Modifications to Equipment

Any changes or modifications to the device that are not expressly approved by 
Sun Nuclear Corporation could void your warranty.

Interaction with Other Electrical Equipment

The device can only be connected to external computer equipment that is 
compliant with IEC 60950-1, Safety of Information Technology Equipment. 
56





Sun Nuclear Corporation 
3275 Suntree Boulevard 
Melbourne, FL 32940 USA

+1 321 259 6862 
sunnuclear.com


	Title
	Preface
	Description
	Health and Safety Instructions
	Finding Additional Information

	Contents
	Introduction
	Parts
	Options and Accessories

	Connections
	Controls

	Standalone Operation
	Position the Monitor
	Install a Fresh Battery
	Replacing the 9V Battery

	Turn on the Display
	Starting a Test
	Interrupting a Test
	Displaying Average and Current
	AVG or CUR During a Test
	AVG or CUR After Test

	Clearing Memory
	Checking Unit Status
	Setting Up Parameters
	Character Set
	Display Turns Off Automatically
	Clearing a Reset
	Low Battery Messages
	Storage Under Power

	Portable Printer (Optional)
	Printer - Parts
	Printer - Description
	Printer Connection and Controls
	Loading the Paper
	Printing a Report
	Typical Printer Report
	Movement
	Temperature, Humidity, Pressure


	Printer Battery Pack
	Printer Switch Settings

	Computer Operation
	About the Software
	Set Up Software
	Prerequisites
	Install Software

	Connecting to Computer
	Launch Software
	Using Software to Retrieve Data
	USB Cable Connection/Disconnection


	Closing Software
	About the Main Screen
	Main Screen - Inspection Tab
	Main Screen - Chart Tab
	Zooming In and Out
	Moving the Chart

	Main Screen - Pictures Tab
	Main Screen - Checklist Tab
	Menu Bar and Toolbar Functions
	Data to/from Text File
	Save Data to File
	Open Data from File


	Monitor Settings Preferences
	Preferences Screen - Monitor Settings Tab Details

	Report Printing Preferences
	Preferences Screen – Print Tab Details

	Printing Reports

	Specifications
	Recommended System Requirements
	Models 1028 and 1029 Specifications

	Support and Maintenance
	Maintaining Hardware
	Repairs
	Inspection
	Storage
	Cleaning
	Disposing and Recycling
	Service and Calibration
	Battery Life

	Maintaining Software
	Verifying Software Version
	Removing Software
	Multiple Software Installations
	Two or More Radon Monitor Units
	Two or More Computers


	Optional Serial Connection
	Serial Port Setup
	Connecting with a Serial Cable
	Port Selection

	Radon Monitor Troubleshooting
	System Errors
	ERR Message
	Notice Message


	Contacting Sun Nuclear Support
	Support Website

	Warranty

	Appendix A: Regulatory Supplement
	Sun Nuclear Corporation Symbols
	Operator Responsibility
	Reporting Health or Safety Related Issues or Concerns
	Modifications to Equipment
	Interaction with Other Electrical Equipment



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<

    /BGR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /ETI <>
    /FRA <>
    /GRE <>

    /HRV (Za stvaranje Adobe PDF dokumenata najpogodnijih za visokokvalitetni ispis prije tiskanja koristite ove postavke.  Stvoreni PDF dokumenti mogu se otvoriti Acrobat i Adobe Reader 5.0 i kasnijim verzijama.)
    /HUN <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>
    /RUM <>
    /RUS <>
    /SKY <>
    /SLV <>
    /SUO <>
    /SVE <>
    /TUR <>
    /UKR <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice




